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OVERVIEW 

WHAT IS MARKMYWORDS? 

MarkMyWords is a Microsoft Word add-in that uses Anthropic’s Claude AI (Artificial 
Intelligence) to copyedit text directly in Microsoft Word. Claude acts as an editorial 
assistant, performing initial reviews and making improvements based on your specific 
instructions in MarkMyWords. All edits appear as tracked changes, allowing you to accept 
or reject each modification and maintain full control over the final content. 

Editing with AI is far different from working with tools like Editor's ToolKit Plus or PerfectIt, 
which use Word macros and advanced find and replace to fix problems. For example, 
PerfectIt might find “non-fiction” and suggest that you replace it with “nonfiction” (without 
the hyphen). With MarkMyWords, Claude might find the same problem but simply fix it (as a 
tracked revision), without your having to approve the change. Claude might also include an 
explanation in a comment: “According to the Chicago Manual of Style (around 7.90), 
‘nonfiction’ is styled as one word without a hyphen.” (You can specify the style guide you 
want to use.) 

MarkMyWords doesn’t use mechanical means like macros to find and fix problems. 
Instead, it uses Claude AI to find and fix problems intelligently, with an awareness of 
meaning and context. For example, my test document about the life of Mark Twain says the 
rock group Creedence Clearwater Revival got one of their lyrics from Twain: “But I never 
saw the good side of the city till I hitched a ride on a riverboat queen.” That, of course, is 
false. Claude deleted the statement and added this comment: “NOTE: The statement 
about Creedence Clearwater Revival contains a factual error. The quoted lyrics are from 
‘Proud Mary’ (1969), not from Twain’s Life on the Mississippi (1883). This sentence should 
be deleted or substantially revised for accuracy.” 

With that kind of intelligence, Claude can significantly streamline your editing workflow. 
Nevertheless, Claude should be viewed as a supportive tool rather than a substitute for 
professional editing. Human oversight remains essential for critical or complex editing 
tasks. 

WHY NOT JUST EDIT WITH AI ONLINE?  

Many AI service providers allow users to upload Word documents with specific instructions 
for editing. However, most online editing tools fail to properly handle such critical features 
as quotation marks, footnotes, endnotes, and comments. These elements are vital for 
maintaining the integrity and clarity of manuscripts intended for publication. Similarly, 
other Word add-ins (including ChatGPT for MS Word) do not handle these features. 
MarkMyWords addresses this gap, ensuring that all these elements are managed 
effortlessly and accurately, directly in Microsoft Word. 

DOES USING CLAUDE ’S API REQUIRE A SUBSCRIPTION?  

No. MarkMyWords uses Claude’s API (Application Programming Interface), which operates 
on a pay-as-you-go basis. Users are billed solely on the amount of text processed, without 
the need for a monthly subscription. This flexible pricing structure is more economical for 
users who require occasional or extensive editing. The rates vary depending on the specific 
Claude model chosen, but generally they are highly affordable. 
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KEY FEATURES 

MarkMyWords includes numerous features to enhance your editing process: 

Professional Editing Presets 

• Light Editing: Minimal corrections for clean manuscripts 

• Heavy Editing: Comprehensive editing for rough drafts 

• Academic Editing: Scholarly writing standards 

• Fiction Polish: Creative writing enhancement 

• Custom Instructions: Your specific requirements 

Complete Control 

• All changes appear as tracked changes 

• Review and accept or reject edits as needed 

• Your document, your final decision 

Multiple AI Models 

• Haiku: Fast and economical for simple edits 

• Sonnet: Balanced performance for most tasks 

• Opus: Premium quality for complex work 

Smart Cost Estimation 

• Real-time cost preview based on selection size and AI model 

• Automatically updates when you change AI models 

• No surprises: see costs before processing 

Flexible Processing 

• Process selected text or entire document 

• Cancel processing at any time 

INSTALLATION 

WINDOWS 

1. Double-click the program installer (MarkMyWords_setup.exe). 
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2. Respond to the prompts on your screen. 

3. After the installation is finished, close and then restart Microsoft Word. You should then 
see a new tab, MarkMyWords, on Word’s Ribbon interface. Click the tab to use the 
program’s features. 

During installation, the program template, MarkMyWords.dotm, is placed in Microsoft 
Word’s Startup folder so that MarkMyWords starts automatically every time you start 
Microsoft Word. 

MACINTOSH 

Place the program template, MarkMyWords.dotm, in Microsoft Word’s Startup folder so 
that MarkMyWords starts automatically every time you start Microsoft Word. The startup 
folder is generally located here: 

~/Library/Group Containers/UBF8T346G9.Office/User Content/Startup/Word 

1.   Copy the path above (the line beginning with "~/Library"). 

2.   Open Finder on your Mac. 

3.   Press Cmd+Shift+G. 

4.   Paste. 

The folder that opens in Finder is the Startup folder. Drag the file MarkMyWords.dotm into 
that folder. 

Close and then restart Microsoft Word. You should then see a new tab, MarkMyWords, on 
Word’s Ribbon interface. Click the tab to use the program’s features. 

GETTING STARTED 

WHAT YOU’LL NEED 

1. Microsoft Word 

• Word 2016 or later with MarkMyWords installed 

2. An Internet Connection 

• Required for AI processing 

3. An API Key from Anthropic 

GETTING YOUR API KEY 

To use MarkMyWords with Claude, you’ll need a free API key from Anthropic: 

1. In your web browser, go to console.anthropic.com. 

2. Create a developer account and sign in. 

http://console.anthropic.com/
http://console.anthropic.com/
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3. Save your login information in a safe place. 

4. Click Get API Key. 

5. Click Create Key and follow the online prompts. 

6. Copy the key and save it in a safe place. If you lose the key, you won’t be able to 
retrieve it, but you can always create another one at console.anthropic.com. 

7. Click Billing on the left-side menu. 

8. Buy credits and edit your settings for auto reload. $10 is a good place to start and 
should last you a long time. You can monitor your API usage at 
console.anthropic.com. 

FIRST-TIME SETUP 

1. Click the MarkMyWords tab in Word’s ribbon. You'll then see the MarkMyWords 
ribbon: 

2. Click Run MarkMyWords. You'll then see the settings dialog: 

 
3. Paste your Claude API key into the box labeled API key. 

4. Click the Test button to see if your computer connects to Claude AI and your API 
key is valid. 

5. Click Save and Close to save and exit. 

http://console.anthropic.com/
http://console.anthropic.com/
http://console.anthropic.com/
http://console.anthropic.com/
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Your API key is saved in your computer’s registry and needs to be entered only once. Never 
share your API key with anyone else. Doing so would allow them to use funds from your 
Anthropic account. 

USING MARKMYWORDS 

BASIC WORKFLOW 

STEP 1: PREPARE YOUR DOCUMENT 

Open your document in Microsoft Word. You can edit: 

• Selected text: Select the portion you want to edit. 

• Entire document: Leave your cursor anywhere without selecting text. 

If your selection already includes tracked revisions or comments, MarkMyWords will advise 
you to accept or reject them before proceeding. 

STEP 2: CHOOSE EDITING PRESET 

Click MarkMyWords > Run MarkMyWords (or press ALT CTRL SHIFT M anywhere in Word 
on PC) and select a preset from the dropdown menu: 

• Light Editing 

• Heavy Editing 

• Academic Editing 

• Fiction Polish 

• Rewrite 

• Simplify 

• Analyze 

• Custom Instructions 

Or use individual checkboxes for specific corrections: 

• ☑ Spelling 

• ☑ Grammar 

• ☑ Punctuation 

• ☑ Clarity 
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• ☑ Conciseness 

• ☑ Word Choice 

STEP 3: SELECT OPTIONS AS NEEDED 

Style Guide: 

• AGS (Australian Government Style Manual) 

• AMA (American Medical Association Manual of Style) 

• APA (American Psychological Association Style Manual) 

• CMOS (Chicago Manual of Style) 

• MLA (Modern Language Association Style Manual) 

• New Oxford Style Manual 

• None. If you select this option, you can specify your own style guide or other 
requirements in the Custom Instructions box. 

Editing Scope (you'll usually want to leave these unchecked): 

• ☑ Include footnotes in selected text 

• ☑ Include endnotes in selected text 

• ☑ Include block quotations and poetry in selected text 

Editing Help (highly recommended): 

• ☑ Include comments explaining changes 

• ☑ Include comments with suggestions for improvements 

• ☑ Attribute revisions and comments to Claude AI 

NOTE:  When Claude cites a style guide in a comment, it includes a link to the style guide 
online. Where possible, Claude includes the probable section number. It can't actually 
access the style guide, but it still has a good idea about what's in there and where it is. If 
you need to look it up, hold down CTRL/CMD and click the link. 

STEP 4: CHOOSE AN AI MODEL 

MarkMyWords supports multiple Claude AI models with different capabilities and pricing. 
Click the Refresh models button to use the latest models as they become available. 

Haiku Models (Fastest, Most Economical) 
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• Best for: Simple corrections, quick reviews 

• Speed: Very fast 

• Cost: Lowest 

• Use when: Working with clean manuscripts needing light touch-ups 

Sonnet Models (Balanced, Recommended) 

• Best for: Most editing tasks, general copyediting 

• Speed: Fast 

• Cost: Moderate 

• Use for: Standard editing work, balanced quality and cost 

Opus Models (Highest Quality, Premium) 

• Best for: Complex editing, high-stakes documents 

• Speed: Slower 

• Cost: Highest 

• Use for: Critical documents requiring maximum attention 

Recommendation: Claude Sonnet 4.5 offers the best balance of quality, speed, and 
cost for most users. 

STEP 5: REVIEW PROCESSING SETTINGS 

Chunk Size (Default: 3000-5000 characters) 

• How much text to send in each API request 

• Larger chunks = fewer requests = potentially lower cost 

• Smaller chunks = better for complex documents with varied content 

• Recommendation: MarkMyWords calculates the optimal chunk size based on the 
selected text and the settings you’re using. Leave this setting at the default unless 
you’re experiencing issues. 

Max Tokens (Default: 100-4000) 

• Maximum response length from AI 

• Higher = more detailed explanations 

• Lower = faster processing 
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• Recommendation: MarkMyWords calculates the optimal number of tokens based 
on the selected text and the settings you’re using. Leave this setting at the default 
unless you’re experiencing issues. 

STEP 6: CHECK COST ESTIMATE 

1. The MarkMyWords dialog shows the estimated processing cost near the bottom. 
Cost estimates are based on: 

o Amount of text selected 

o Chosen AI model 

STEP 7: PROCESS 

1. If you approve of the estimated cost, click Edit with Claude. 

2. Progress window appears showing: 

o Processing status 

o Progress bar 

o Number of chunks completed 

o Cancel button (if you need to stop). The Cancel button is inoperable (grayed 
out) while Claude is working on a chunk of your document. But between 
chunks, the Cancel button briefly turns blue. If you click it then, further 
processing is canceled. Any previous processing is marked with tracked 
changes in your text. 

STEP 8: REVIEW RESULTS 

All edits appear as tracked changes: 

• Strikethrough = deleted text 

• Underline = inserted text 

• Comments = explanations and suggestions (if enabled) 

Review each change and accept or reject as needed. 
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PRESETS AND SPECIFICS 

 

LIGHT EDITING 

Purpose: Minimal corrections for manuscripts that are already in good shape. 

What It Does: 

• Corrects obvious spelling errors 

• Fixes clear grammar mistakes 

• Adjusts punctuation where necessary 

• Maintains author’s voice and style 

When to Use: 

• Clean manuscripts needing final polish 

• Documents from experienced writers 

• When you want to preserve maximum author voice 

Cost: Lowest processing time, uses fewer tokens 

HEAVY EDITING 

Purpose: Comprehensive editing for manuscripts needing significant improvement. 

What It Does: 

• All corrections from Light Editing 

• Restructures unclear sentences 

• Improves word choice throughout 
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• Enhances overall clarity and flow 

• May suggest significant rewording 

When to Use: 

• Rough drafts 

• Non-native English speakers 

• Manuscripts with structural issues 

• When quality is more important than preserving exact wording 

Cost: Moderate to high, depending on manuscript length 

ACADEMIC EDITING 

Purpose: Ensures scholarly writing meets academic standards. 

What It Does: 

• Applies formal academic tone 

• Ensures proper citation format awareness 

• Improves clarity of complex concepts 

• Maintains discipline-specific conventions 

• Checks for appropriate hedging language 

When to Use: 

• Research papers 

• Dissertations and theses 

• Journal article submissions 

• Academic books 

• Conference papers 

Best Combined With: Style guide selection (APA, Chicago, MLA, etc.) 

FICTION POLISH 

Purpose: Enhances creative writing while preserving narrative voice. 

What It Does: 

• Maintains author’s unique voice 
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• Improves dialogue naturalism 

• Enhances descriptive language 

• Checks narrative consistency 

• Preserves intentional style choices 

When to Use: 

• Novels and short stories 

• Creative nonfiction 

• Memoirs 

• Any narrative-driven work 

Special Consideration: Fiction editing respects creative choices and focuses on clarity 
without over-correcting style. 

REWRITE 

Purpose: Rewrites text as needed for improved clarity or different audience. 

What It Does: 

• May significantly alter sentence structure 

• Changes word choice extensively 

• Can modify tone and style 

• Aims for maximum clarity 

• May shorten or lengthen text 

When to Use: 

• Text that’s difficult to understand 

• Changing target audience level 

• Converting technical to general audience 

• When original wording can be completely changed 

Warning: This mode makes extensive changes. Use Light or Heavy Edit for preserving 
more original text. 

SIMPLIFY 

Purpose: Makes complex text easier to understand. 
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What It Does: 

• Reduces sentence complexity 

• Replaces difficult words with simpler alternatives 

• Breaks up long sentences 

• Improves readability score 

• Maintains core meaning 

When to Use: 

• Technical documents for general audiences 

• Educational materials 

• Public-facing content 

• When accessibility is important 

ANALYZE 

Purpose: Provides extensive feedback in Microsoft Word comments. 

What It Does: 

• Identifies issues 

• Suggests improvements 

• Points out patterns 

• Provides commentary 

When to Use: 

• Getting feedback 

• Understanding manuscript weaknesses 

• Learning about writing patterns 

CUSTOM INSTRUCTIONS 

Tailored editing for specific requirements. 
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The MarkMyWords presets may do everything you need, but if you want to give Claude 
additional instructions, you can enter your requirements in the Custom Instructions text 
box. Your instructions are added to the default instructions included in the editing presets 
and specific options (such as Light Editing, Heavy Editing, Spelling, and Grammar). 
However, if you choose Custom Instructions as a preset, only your custom instructions 
are sent to Claude, bypassing the built-in instructions in the editing presets and specific 
options. 

Writing custom instructions (or prompts) for AI is a skill worth acquiring. You’ll find lots of 
help with this online. In general, AI does a better job if you include the following kinds of 
information in your instructions. 

• AI role: “You are a highly skilled ad writer.” 

• Intended audience: “Your readers receive an email newsletter about editing.” 

• Instructions: “Punch up this ad copy for the newsletter so that it’s more enticing.” 

• Exceptions: “IMPORTANT: Do NOT change the offer or terms in the ad copy.” 

The better and more specific your instructions, the better response you will get from 
Claude. 

Writing AI instructions is an iterative process: Send your instructions, review the results, 
revise your instructions, try again. When you get results you like, save your instructions in a 
separate document for future use. 

AI is both amazingly smart and frustratingly dense. It’s really good at understanding your 
instructions, but it may not always follow them exactly. Sometimes it just does what it 
thinks best. In fact, resending the same instructions for the same text to be edited may 
produce slightly different results. In addition, as the Claude.ai website warns, “Claude is 
AI and can make mistakes. Please double-check responses.” That is why you should never 
rely on Claude (or any other AI engine) to do your editing for you. You must review its results 
while doing your own editing, thus making sure your final edit is everything you want it to be. 

How to Use: 

1. Enter detailed instructions in the Custom Instructions text box. 

2. Select the presets and options you want to use with your instructions. If you want to 
use only your custom instructions, select Custom Instructions from the dropdown 
presets. 

https://claude.ai/
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With experience, you can (and should) assemble a library of instructions that help Claude 
do exactly what you need. If you're not sure how to phrase a custom instruction, you can go 
to Claude.ai and ask Claude to give you a prompt that will produce the results you want. 

Example Instructions: 

• Enforce the Oxford comma 

• Enforce British English spelling, punctuation, and quotation marks 

• Where possible, check the accuracy of quotations 

• Focus on clarity rather than style 

• Ensure consistent past-tense narration 

• Match the editorial style of [publication name] 

• Preserve numerical data exactly 

• Use active voice wherever appropriate 

• Avoid contractions 

• Target 8th-grade reading level for general audience sections 

• Enforce the following items as editorial style: 

o Capitalize a word following a colon if the word begins a complete sentence. 

o Replace such abbreviations as "i.e.," "e.g.," "etc." with a plain-English 

equivalent, such as "that is," "for example," "and so on." 

o Italicize names of movies, television programs, music albums, and books. 

o Form plurals of acronyms by adding a lowercase "s" without an apostrophe. 

Tips for Effective Custom Instructions: 

• Be specific and clear 

• Specify what NOT to change 

• Specify what to preserve 

• State priorities (e.g., “clarity over brevity”) 

• Mention target audience 

http://claude.ai/
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UNDERSTANDING COSTS 

HOW COSTS ARE CALCULATED 

MarkMyWords calculates the estimated cost for Claude to process the text you’ve 
selected. You’ll find that information at the bottom of the AI Processing section of Claude’s 
settings: 

MarkMyWords shows real-time cost estimates based on: 

1. Text Length 

• Number of characters in selection 

• Approximately 4 characters per token 

• Plus overhead for instructions 

2. Approximate Editing Cost for AI Model Selected 

• Haiku: $0.005 per 1,000 tokens 

• Sonnet: $0.015 per 1,000 tokens 

• Opus: $0.025 per 1,000 tokens 

All of the models are surprisingly affordable. Suppose you’re editing a novel of 80,000 
words with an average word length of 5 characters. That gives you a character count of 
400,000. Divide that by 4 to get the number of tokens required: 100,000. Then divide that by 
1,000, resulting in 100 sets of tokens so you can calculate the cost. 

Using Haiku, the approximate processing cost for the 80,000-word novel would be: 

• 100 x .005 = $.50 

Using Sonnet: 

• 100 x .015 = $1.50 
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Using Opus: 

• 100 x .025 = $2.50 

Claude’s models and processing costs are subject to change. Always check the cost 
estimate before editing with Claude, and monitor your API usage at 
console.anthropic.com. You can also check the current pricing at Anthropic's pricing 
page. The prices are listed in millions of tokens, so to calculate the price per thousand, 
divide the listed price by 1,000. For example, Claude Opus 4.6 is listed at $5/Mtok ($5 per 
million tokens). Divide $5 by 1,000, resulting in 0.005. But there's no need for you to 
calculate cost; MarkMyWords does it for you. 

MANAGING COSTS 

Tips to Reduce Costs: 

1. Before running MarkMyWords, clean up your document using FileCleaner, 
MegaReplacer, and other features in Editor’s ToolKit Plus, thus requiring less work 
from Claude. Learn more at www.editorium.com. 

2. Start with selections: Test on a paragraph or two before processing entire 
documents. 

3. Use Haiku for simple tasks: Correcting errors in spelling and grammar works well 
with the economy model. 

4. Use Sonnet for more complex tasks: Intelligent editing that catches problems an 
editorial assistant might spot. Sonnet works well for everyday work. 

5. Reserve Opus for final passes: Use Opus to check the final version of your work in 
detail. 

6. Process in stages: Edit chapter by chapter rather than all at once. 

7. Review cost estimate: Always check before clicking Edit with Claude. 

8. Frequently monitor your API usage at console.anthropic.com 

WORKING WITH RESULTS 

UNDERSTANDING COMMENTS AND ATTRIBUTION 

The MarkMyWords settings dialog has the option to include comments from Claude that 
explain substantial changes and provide suggestions for improvement: 

http://console.anthropic.com/
http://console.anthropic.com/
https://platform.claude.com/docs/en/about-claude/pricing
https://platform.claude.com/docs/en/about-claude/pricing
http://www.editorium.com/
http://console.anthropic.com/
http://console.anthropic.com/
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These are standard Microsoft Word comments, appearing in the task pane on the right: 

 

For this to work properly, you’ll need to use the following setting in Word under File > 
Options > General: 

 

• Enter your user name and initials. 
• Make sure the checkbox is checked for “Always use these values regardless of sign 

in to Office.” 
• Click OK to make these options permanent. 

Then, in MarkMyWords, select the option Attribute revisions and comments to Claude AI 
to have Claude’s comments and revisions attributed to “Claude AI.” If you do not select 
that option, Claude’s comments and revisions are attributed to you instead. 

Clicking one of Claude’s comments selects the associated revisions, which you can then 
accept or reject together. Claude may also place general comments (labeled as “NOTE”) at 
the end of the document rather than with any specific text. 

MarkMyWords includes a utility to change existing “Claude AI” attributions to your name 
after the fact: 

 

The utility works on selected text. If you don't make a selection, MarkMyWords selects the 
entire document. You have the option to cancel if you change your mind. 
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UNDERSTANDING TRACKED CHANGES 

All of Claude’s edits appear in Microsoft Word’s tracked changes: 

• Strikethrough: Deleted text (original wording being removed) 

• Underline: Inserted text (new wording being added) 

• Comments: Explanations and suggestions for changes (if enabled) 

REVIEWING REVISIONS 

Step 1: Access Review Tab 

• Click the Review tab in Word’s ribbon or the MarkMyWords Review revisions 
button. 

Step 2: Navigate Changes 

Use Review tab buttons: 

• Next: Jump to next change 

• Previous: Jump to previous change 

Step 3: Accept or Reject 

For each change: 

• Accept: Keep the edit 

• Reject: Revert to original 

• Accept All: Keep all changes (use cautiously!) 

• Reject All: Discard all changes 

REVIEWING REVISIONS WITH KEYBOARD SHORTCUTS (WINDOWS ONLY) 

Reviewing revisions is actually rather cumbersome in Word. First, you must use the mouse 
to click the Previous and Next icons on the Review tab of the Ribbon, when using keyboard 
shortcuts would be much easier. Second, whether the text is marked for insertion or 
deletion, it’s still there on the screen. And to make it go away (or to retain it) requires a 
different action for an insertion than it does for a deletion—and therein lies the problem. 

Consider: To remove inserted text, you must reject the revision. To retain inserted text, you 
must accept the revision. 

Conversely, to remove deleted text, you must accept the revision. To retain deleted text, 
you must reject the revision. 

How confusing! Here’s a grid that shows what happens: 
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Revision Type Accept Reject 

Insertion Text retained Text removed 

Deletion Text removed Text retained 

When reviewing revisions using this system, you actually have to make three decisions for 
every revision you encounter: 

1. How is the text marked—as a deletion or an insertion? 
2. Do you want to keep the marked text or get rid of it? 
3. So do you accept the revision or reject it? 

Really, all you should have to think about is number 2: Do you want to keep the marked text 
or get rid of it? Then Word should be smart enough to deal with your decision in the 
appropriate way. Unfortunately, that is not the case. But MarkMyWords includes custom 
keyboard shortcuts (Windows only) that fix the problem: 

•     ALT CTRL SHIFT RIGHT ARROW takes you to the next revision. 
•     ALT CTRL SHIFT LEFT ARROW takes you to the previous revision. 
•     ALT CTRL SHIFT UP ARROW retains the current revision. 
•     ALT CTRL SHIFT DOWN ARROW removes the current revision. 

And it does so whether the revision is an insertion or a deletion, making those four keyboard 
shortcuts a nice combination. You can use them to: 

•     Find the next or previous revision (either insertion or deletion). 
•     Retain or remove the revision (as opposed to accepting or rejecting it). 

This makes reviewing revisions easy, quick, and intuitive. After you’ve tried it, you’ll wonder 
how you ever managed to review revisions the old way (which, of course, you can continue 
to do if you like). 

BEST PRACTICES FOR REVIEWING 

1. Review in Order 

• Start at document beginning 

• Work through sequentially 

• Don’t skip sections 

2. Read Context 

• See changes in surrounding text 

• Ensure edits make sense 

• Check for unintended changes in meaning 
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3. Check Comments 

• Click a comment to select the associated text 

• Consider the explanations and suggestions in Claude’s comments 

• Learn from Claude’s suggestions 

4. Watch for Patterns 

• Note recurring issues 

• Identify personal writing habits 

• Apply lessons to future writing and editing 

5. Trust Your Judgment 

• You’re the final authority 

• Reject changes that alter meaning 

• Accept improvements that enhance clarity 

PARTIAL PROCESSING RESULTS 

If necessary, you can cancel processing. 

MarkMyWords displays a progress bar while processing your document. To stop 
processing, click the Cancel button on the progress bar. The Cancel button is inoperable 
(grayed out) while Claude is working on a chunk of your document. But between chunks, 
the Cancel button briefly turns blue. If you click it then, processing is canceled. 

If You Cancel Processing: 

MarkMyWords preserves all changes made before cancellation: 

• First chunks: Fully edited with tracked changes 

• Remaining chunks: Unprocessed 

• Document remains valid and usable 

KEYBOARD SHORTCUTS (WINDOWS ONLY) 

MarkMyWords includes keyboard shortcuts to make your work easier: 

SHORTCUTS TO REVIEW EDITING CHANGES  

•     ALT CTRL SHIFT RIGHT ARROW takes you to the next revision. 
•     ALT CTRL SHIFT LEFT ARROW takes you to the previous revision. 
•     ALT CTRL SHIFT UP ARROW retains the current revision. 
•     ALT CTRL SHIFT DOWN ARROW removes the current revision. 
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ADVANCED FEATURES 

BLOCK TEXT FILTERING 

Purpose: Exclude specific text styles from processing 

Common Uses: 

• Skip block quotations and poetry 

• Preserve code blocks 

• Exclude pull quotes 

• Maintain specialized formatting 

How to Use: 

• Text styled as “Block Text” or “Poem” (and variations thereof) is automatically 
skipped during processing. 

Applying Block Text Style: 

1. Select text to exclude. 

2. Apply “Block Text” style from Word’s Style gallery. 

3. Run MarkMyWords: that text will remain unchanged. 

TROUBLESHOOTING 

MARKMYWORDS TAB NOT APPEARING 

Cause: Add-in not properly installed or macro security blocking 

Solution 1: Verify Installation 

1. Check that the program file (MarkMyWords.dotm) is in Word’s STARTUP folder. 

2. Close Word completely and reopen. The MarkMyWords tab should appear on 
Word’s ribbon. 

Solution 2: Enable Add-in Manually 

1. Click File → Options → Add-ins. 

2. At bottom, select Word Add-ins from dropdown. 

3. Click Go. 

4. Check the box next to MarkMyWords. 

5. Click OK. 
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INVALID API KEY ERROR 

Cause: API key entered incorrectly or invalid 

Solution: 

1. Visit console.anthropic.com. 

2. Verify your API key. 

3. Copy entire key (starts with “sk-ant-”). 

4. Open MarkMyWords settings. 

5. Paste key in the API Key box (don’t type manually). 

6. Click OK. 

Common Mistakes: 

• Missing characters when copying 

• Extra spaces at beginning or end 

• Using expired API key 

• Using API key from wrong account 

API CALL FAILED ERROR 

Cause 1: No Internet Connection 

• Check your network connection 

• Verify firewall isn’t blocking Word 

Cause 2: API Credits Depleted 

• Check account at console.anthropic.com 

• Add credits if balance is zero 

Cause 3: Rate Limiting 

• Wait a few minutes 

• Process smaller chunks 

• Spread processing over time 

PROCESSING TAKES A LONG TIME 

Cause 1: Large Document with Slow Model 

• The advanced Opus models are slower than Sonnet/Haiku 

http://console.anthropic.com/
http://console.anthropic.com/
http://console.anthropic.com/
http://console.anthropic.com/
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• Switch to Sonnet or Haiku for faster processing 

Cause 2: Internet Speed 

• Large documents require uploading text 

• Slower connections increase time 

• Consider processing in smaller chunks 

Cause 3: High API Load 

• Anthropic’s servers may be busy 

• Wait awhile and try again 

• Try during off-peak hours 

CANCEL BUTTON NOT WORKING 

Expected Behavior: 

• Cancel takes 1–5 seconds to respond 

• Finishes current chunk before stopping 

If Processing Never Stops: 

1. Wait 30 seconds. 

2. Close progress window. 

3. Close and reopen Word if necessary. 

FREQUENTLY ASKED QUESTIONS  

GENERAL QUESTIONS 

Q: Is my document secure? 
A: Yes. MarkMyWords sends your text to Anthropic’s secure servers for processing, but 
Anthropic does not use that text for AI training purposes, and your text is not stored 
permanently online. You can learn more at console.anthropic.com by clicking your initials 
at the lower left of your browser window and selecting “Legal center.” 

Q: Does MarkMyWords work offline? 
A: No. An internet connection is required to communicate with Claude AI servers. 

Q: What languages does MarkMyWords support? 
A: Claude AI has strong English capabilities and can work with many other languages, 
though quality varies. English editing produces best results. 

Q: Can I edit multiple documents simultaneously? 
A: No. Process one document or one part of a document at a time. 

http://console.anthropic.com/
http://console.anthropic.com/
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Q: Does MarkMyWords modify my original file? 
A: Yes. All edits appear as tracked changes, which you can accept or reject. Your original 
text remains accessible until you explicitly accept changes. You should also keep a backup 
of your file before using MarkMyWords. 

COST AND BILLING 

Q: How am I billed? 
A: Billing is through your Anthropic API account at console.anthropic.com. You’re charged 
only for actual processing (tokens used), not for opening MarkMyWords or viewing 
estimated cost. 

Q: Why do costs vary? 
A: Costs depend on text length, AI model chosen, and whether you include comments from 
Claude. Longer text and premium models cost more. 

Q: Can I set a spending limit? 
A: Not within MarkMyWords, but you can set usage limits in your Anthropic API account at 
console.anthropic.com. 

Q: What if I run out of credits mid-processing? 
A: Processing will stop. Add credits to your account and re-run on remaining text. You can 
also configure your Anthropic console to automatically add additional funds if needed, with 
a cap on the amount. 

Q: How do I see how much I’ve spent on processing with Claude? 
A: Monitor your API usage at console.anthropic.com. 

TECHNICAL QUESTIONS 

Q: Why do I need to see chunk size and max tokens? 
A: These control how text is divided for processing. Default values work well for most uses. 
Advanced users can adjust for specific needs. 

Q: What’s the difference between models? 
A: Haiku is fastest and cheapest, Sonnet is balanced, Opus is highest quality but slowest 
and most expensive. Sonnet is recommended for most users. 

Q: Can I use my own Claude Plus subscription? 
A: No. MarkMyWords requires an API key from console.anthropic.com, which is separate 
from Claude.ai subscriptions. You do not need a Claude Plus subscription to use 
MarkMyWords. 

Q: Does MarkMyWords store my API key? 
A: Yes, in the Windows Registry. It’s accessible to MarkMyWords on your computer and to 
Anthropic when you’re using Claude for editing. Never share your key with anyone else. 

USAGE QUESTIONS 

Q: Should I process my entire book at once? 
A: No. Processing a long document can take a long time. It's better to process chapter by 
chapter or in selected text. This provides better cost control and allows reviewing as you go. 

http://console.anthropic.com/
http://console.anthropic.com/
http://console.anthropic.com/
http://console.anthropic.com/
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Q: Can I undo processing? 
A: Yes. Reject all tracked changes to return to your original text. In addition, you should 
always back up your documents before processing with MarkMyWords. 

Q: What if Claude makes a mistake? 
A: Simply reject that change in tracked changes. You have complete control over what stays 
and what goes. 

Q: Can I use MarkMyWords with academic integrity? 
A: Yes. MarkMyWords is an editing tool like a grammar checker. You’re responsible for the 
final content. All changes are visible as tracked changes for transparency. 

Q: How do I cite using MarkMyWords? 
A: MarkMyWords is an editing tool. Citation depends on your institution’s AI policy. Some 
consider it like Grammarly (no citation needed), while others may require disclosure. 

ADVANCED USAGE 

Q: Can I edit the add-in’s code? 
A: No. Nor would you want to. It's hideously complex and includes more than 12,000 lines 
of code. Programming in VBA is hard enough, but getting it to work with AI is extraordinarily 
difficult, as AI has a mind of its own! It's sometimes difficult to know if something doesn't 
work because the code is wrong or because your AI prompts need adjusting. 

Q: Can I create custom editing modes? 
A: Yes. Use the Custom Instructions box to create any editing approach you need. 

Q: Can I batch process multiple files? 
A: No. Process each file individually. 

REGISTRATION 

If you like MarkMyWords and plan to continue using it, you must purchase a license to do 
so. If you don’t, your copy of the program is for evaluation only, and it will stop working after 
45 days. After you purchase a license to use the program, you’ll automatically receive a 
password (by email) that will unlock the program to run without limitation on time or use. 

The terms of your license prohibit you from giving your program password to someone else 
or using it on someone else’s computer. However, you may use the password for your own 
use on up to three computers. For example, you could install MarkMyWords and use your 
password on your computer at work, your computer at home, and your laptop. However, 
you may actually run the program on only one of your computers at a time. If you need to 
run the program on more than one computer at a time (for example, for concurrent use by a 
family member or employee), you must purchase another license and get another 
password for the program. This is the honest and legal thing to do. Besides that, the 
Editorium is a very small business that needs your support. Thanks for your cooperation. 

GETTING A PASSWORD 

Here’s how to purchase a program license so you can get your password: 

1. Go to www.editorium.com/register.htm and click MarkMyWords. 

http://www.editorium.com/register.htm
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 Or, in Word, click MarkMyWords > Register MarkMyWords > Purchase MarkMyWords. 

2. Follow the online instructions. 

You’ll receive your password automatically by return email as soon as your payment is 
processed. If you’re paying by credit card, you’ll receive your password almost 
immediately. Just check your email as soon as your online registration is complete. 

USING YOUR PASSWORD 

Once you’ve received your password from the Editorium, you’ll need to enter it into the 
MarkMyWords program. To do so, click MarkMyWords > Register MarkMyWords. The 
Registration dialog will appear on your screen: 

Carefully type (or, better, paste) the password into the box labeled “Please enter your 
password/ registration code.” Then click the OK button. 

If you have a valid password and enter it correctly, the program will say your registration 
was successful. After that, the program will run without limitation on time or use. 

QUESTIONS? 

I hope you find MarkMyWords to be immensely useful. If you have questions, comments, or 
thoughts about how it could be improved, please let me know. 

support@editorium.com 

The Editorium provides word-processing tools for editors, writers, indexers, typesetters, 
and other publishing professionals. You can download fully functioning evaluation copies 
of these tools free of charge from the Editorium’s site at www.editorium.com. 

TERMS OF AGREEMENT 

By using MarkMyWords, you agree to these terms: 

LICENSE AGREEMENT 

The MarkMyWords software and its documentation (collectively the Software) are 
protected by the United States copyright laws and international treaties and are owned 
solely and entirely by the Editorium (the licensor). 

http://www.editorium.com/
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You (the licensee) may install the Software for your own use on up to THREE computers (for 
example, at work, at home, and on a laptop). You may evaluate the Software at no charge 
for up to 45 days. After that, you must purchase a license to continue using the Software. 

You may freely transfer copies of the Software to others for evaluation. You may NOT let 
someone else use your password for the Software or rent or lease your license to run it, but 
you may transfer the license to someone else who accepts this agreement. 

You may not modify, reverse engineer, decompile, disassemble, unencrypt, or create 
derivative works from the Software. You may not use the Software in any manner that 
infringes the intellectual property or other rights of another party. You may not copy or sell 
the Software for commercial gain. 

DISCLAIMER OF WARRANTY AND LIABILITY 

The Editorium disclaims all warranties on the Software, expressed or implied, including but 
not limited to warranties of merchantability and fitness for any particular application, use, 
or purpose. You use it at your own risk. Under no circumstances, including its own 
negligence, shall the Editorium or its suppliers be liable for any special, incidental, or 
consequential damages or loss that result from the use of, or the inability to use, the 
Software. 

This agreement shall be construed, interpreted, and governed by the laws of the State of 
Utah in the United States of America. 


